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1. Introduction

MEOS, the Mandela Ethics Online System, is a web-based management system that facilitates the
ethics review process from approval of original ethics application to closure of the project.

All applications/reports with respect to a research study requiring ethics clearance are created,
submitted, reviewed, and approved on MEQS, providing one central storage repository where users
can access all approved ethics submissions, approval letters and correspondence relating to an
application.

MEOS covers the following ethics submissions:
° Applications for ethics approval
° Amendments
° Extensions
o Progress reports
° Adverse event/violation/deviation reports
° Closure reports

Researchers from other institutions requiring access to Nelson Mandela University students/staff

for research purposes cannot apply on MEQOS. The process to obtain ethics approval for such
research can be found on the RECH website.

2. Logging in as a REC-A Reviewer

Navigate to the MEOS reviewer site using the URL — meos-review.mandela.ac.za

Sign in using your Mandela University credentials. These are the same log in details that are used to
access your Mandela emails, the staff/student portal, etc.

Nelson Mandela University

Sign in with your organizational account

michelleab@mandela.ac.za

9000000000000

After signing in, you will be directed to your work area for reviews.


https://rd.mandela.ac.za/Research-Ethics/Research-Ethics-Committee-Human-(REC-H)
https://meos-review.mandela.ac.za/

3. Work Area Screen

Work Area

Work Area

Notifications Contacts Reports
N M)
3 /I “\_," {‘\/"
My Reviews (RECA) =
Meeting Reviews Electronic Reviews Liaison Reviews

[ 0 0
The Work Area Screen is divided into three sections:
° Top Bar: black bar across top of screen

° General Work Area: 3 tiles — Notifications, Contacts, Reports
° Specific Work Area: Tiles pertaining to specific reviews required by you

3.1. Top Bar

There are various features you can access from the Top Bar.

(a) Personal Details

Your personal details are accessed by clicking on the arrow on the right of your email address
on the top bar.

Work Area Contact Report Help~ Dr MEOS Test2 (MEOS.Test2@mandela.ac.za) v

Personal Details

Work Area

To update your personal details, complete the Personal Details form and save using the
[Change Details] button.



Title

First Name"

Last Name* Khan
Organisation  Nelson Mandela Universi

Department

Faculty

Campus

Qualification

Telephone @v
Fax

Address 1

Address 2

Town/City

County/State

Postcode

Country

Change Details

(b) Help

The Help dropdown has various options.

Work Area

Help
FAQ

Work Area

About

Notifications Contacts Reports Contact Us

° Help — not populated

° FAQs — not populated

° Templates — access to review templates if any
° About — not populated

° Contact Us

(c) Reports

The Reports area contains any reports that the REC-A administrators have compiled and
shared with the entire REC-A committee.

(d) Contacts

The REC-A administrators may add people external to Nelson Mandela University as a contact
for example, an expert in a specific field. These contacts will appear in this section. Their
details can be updated by clicking on the required contact name.



Full Name / Email Organisation Town / City
Ms Shelly Barnett mbarnettpitts@gmail.com N/A

To update a contact, complete/amend the fields and [Update].

First Name* Shelly
Last Name* Barnett
Organisation N/A
Department
Faculty
Campus
Country
Email* mbarnettpitts@gmail.com

Telephone

Mobile

Committees* Research Ethics Committee (Anim:

(e) Work Area

This takes you back to the main Work Area screen.

3.2. General Work Area

The general work area contains three default tiles.

Notifications Contacts Reports

3 [ 0

(a) Notifications

Clicking on the Notifications tile displays all notifications that are relevant to you as a reviewer.
Notifications can be searched on message content and/or date. Old notifications can be
deleted by clicking on the X next to a message.



Notifications

Search

Start End

Display

Message

RECA Liaison.

v ™ Ethics submission assigned to meeting for review.

-] « ™ Ethics submission assigned to meeting for review.

The following submission reviewer types were assigned to you:

Please note that only the specified number of notifications will show after sea

Attachments

None

None

None

Reference
2022-REC-A-
0101-175
2022-REC-A
0102-178
2022-REC-A-
0102-176

Committee
Research Ethics
Committee (Animal)
Research Ethics
Committee (Animal)

Research Ethics
Committee (Animal)

Date

26/10/2022

21/10/2022

27/09/2022

(b) Contacts

The Contacts tile brings up any external contacts that have been added to MEOS by the ethics

administrators. This may include subject experts, legal experts, etc.

(c) Reports

The Reports area contains any reports that the REC-A administrators have compiled and

shared with the entire REC-A committee.

3.3. Specific Work Area

These tiles, as shown below, are specific to you as a reviewer.

° Meeting Reviews — contains all protocols for review for an upcoming meeting.
° Electronic Reviews — protocols assigned for electronic review (round-robin).
° Liaison Reviews — contains all protocols to which you have been assigned as the REC-A

Representative after a meeting.

° Referrals — contains any protocols which you have been asked to review or comment

on by the designated REC-A Representative.

My Reviews (RECA) =

Meeting Reviews

| 0

Electronic Reviews

Liaison Reviews

0




4. Functionality on an Application Explained

You will be sent an email when applications/reports have been assigned to a meeting for review or
have been assigned for electronic review (round-robin). Log into MEOS. The number of reviews
that need to be completed is indicated on the Meeting Reviews tile or Electronic Reviews tile.

My Reviews (RECA) =

Meeting Reviews Electronic Reviews Liaison Reviews

2 0 0

Click on the tile to list the applications to be reviewed. The list can be sorted, if required, by clicking
on the arrows to the left of a column title.

Meeting Review Project Application Applicant Applicant First Applicant Last Review

Start Date Reference Id Type Project Title Title Name Name Status
2022-REC-A-0104- Application RECA RESEARCH Assigned to

25/11/2022 12:00 104 M Michell Barnett

02 184 (Research) Epsilon TEST e e bl Meeting (RECA)
2022-REC-A-0105- Application RECA Research Zeta N Assigned to
3 o 1 I
25/11/2022 12:00 183 05 (Résearch) TEST Mrs Michelle Barnett Meeting (RECA)

Click on the required submission in the list of applications to open it. This opens to the main page
of the submission.

ﬁk Area

Actions

@ Zoomir @, Zoom Out Vi

Assign to Meeting (RECA)




4.1. The Action Panel

The left-hand Actions panel, indicated above, has the following action buttons:

Form submissions — indicates the number of submission (or versions) of a particular
form. When a form is ‘sent back’ to an applicant for revision, all signatures are
invalidated and after revisions are made, the form must be signed and resubmitted
again. Each submission of a form is considered to be a separate form version.

Project submissions — indicates the number of submissions made on the project as a
whole — includes amendments, extensions, progress reports, etc.

Panel Comments — indicates the number of comments that you have made. Panel
comments are specific to the separate questions on the form.

Form Comments — indicates the number of general comments made about the form as
a whole.

Review Application — opens up the form questions that have been completed by the
applicant.

RECA_Review Feedback — indicates that you have completed your review of the form
and alerts the ethics administrators of this.

4.2. The Timeline Tab

Scrolling down the page reveals the Timeline tab. This shows the various statuses of this particular
form submission both on a graph and below as separate actions. (Please ignore the Clock Status and
Clock Information columns).

Qm!y Project Documents Data Contacts
@\ Zoom In e\ Zoom Out View by Status
RECA_Checked
Submit Application
Assign to Meeting (RECA)
0 22:00 2300 00:00 01:00 02:00 03:00 04:00 0500 06:00 07:00 08:00 09:00 10:0p 11:00 12:00 13:00  14:00
Tuesday 1 November 2022
Action Event Date Clock Status Clock Information Attachment Email
Assign to Meeting (RECA) 01/11/2022 07:31 0/0 days remaining.
RECA_Checked 01/11/2022 07:31 @ 0/0 days remaining.
Submit Application 01/11/2022 07:07 & 0/0 days remaining.
Clicking on either a blue speech bubble or one of the listed actions, reveals further information

about the action that has been performed.




Event Information

Event: Assign to Meeting (RECA)
Start Date: Tuesday, November 1, 2022
Recorded Date: Tuesday, November 1, 2022
Clock Action: Start

Status Before: Submission Checked (RECA)
Status After: Assigned to Meeting (RECA)
Attachment:

Performed By: Michelle Barnett

Timeline Notes:

Action Detail:

Close

4.3. The Project Tab

Clicking on the Project tab provides a brief overview of the project as a whole and all form
submissions. On a new project, the following will be displayed.

Timeline Project Documents Data Contacts

RECA Research Zeta TEST

REC-A: Initial Application (Research)

However, on an older project, there may be a number of submissions displayed. This is very useful
when reviewing a sub-form of a project, for example, an amendment. You can easily open and check
the original approved application or an adverse event report, etc. To access these other forms for a
project, click on the required form to view it.

Timeline Project Documents Data Contacts

RECA PRACTICAL Beta TEST
REC-A: Initial Application (Practicals)
REC-A: Adverse Event/Violation/Deviation (Practical)
REC-A: Annual Progress Report (Practical)
REC-A: Documentation Upload/Additional Information

REC-A: Amendment (Practical)




4.4. The Documents Tab

The documents tab provides access to all documents uploaded with a particular form submission.

These can be viewed or downloaded.

Timeline Project Documents

Form Documents

0 Type

() Submission

1 REC-A Use of Scheduled
Substances

REC-A Supervising Vet
Declaration

M) REC-A Departmental
Approval

()  REC-A Additional
Documentation

Document Name

Submission

REC-A Use of Scheduled
Substances

REC-A Supervising Vet
Declaration

REC-A Departmental
Approval Declaration

Test Document 1

Data Contacts

Version

File Name Date Version

Submission.pdf
REC-A Use of Scheduled
Substances.doc

REC-A Supervising Vet
Declaration.doc

REC-A Departmental Approval
Declaration.doc

Test Document 1.docx

Showing 1 to 5 of 5 entries

View Selected

Size

82.0
KB

70.0
KB

69.0
KB

21.8
KB

Download

Download

Download

Download

Download

Download

Download Selected

4.5. The Data Tab

This tab is not currently in use.

4.6. The Contacts Tab

The Contacts Tab lists both form and review contacts added to the form. The screenshot below
indicates the PRP and PI. This list could include co-workers, lab technicians, etc.

Timeline Project

Form Contacts

Full Name

Mrs Michelle Barnett

Ms Candy Sweet

Showing 1 to 2 of 2 entries

Review Contacts

Documents

Email

Michelle.Barnett@mandela.ac.za

Candy@gmaile.com

Note: There are currently no contacts listed.

Contacts

Organisation

Nelson Mandela University

NMU

First

Previous

Type
PRP

Pl

1 Next Last




5.

Q

Review
Application

Reviewing an Application

10

Click on the [Review Application] button in the left-hand action panel of an opened submission to
access the sections and questions on a form.

Work Area
Actions
Timeline View as PDF
Panel Changes
Comments

Z

Documents

0

Form
Comments

Review Reference: 2022-REC-A-0104-184

Project id 104

REC-A: Initial Application (Research)

Section

Section 1: Type of Research Study

Section 2: Investigator Information

Section 3: General Particulars of Study

Section 4: Experimental Design and Procedures

Section 5: Risks and Benefits

Section 6: Permits

Section 7: Use of Data from External Animal Sample Collection
Section 8: Use of Biological Samples from External Institution/Group
Section 9: Departmental Approval/Additional Information

Section 11: Declaration and Signatures

Versior Beta
Questions
Research Study Type / Recommended Reading

PRP/P| Details | Co-workers | Supervising Veterinarian(s)
General Particulars of Study

Animal Information | Experimental Design and Procedures
Risks and Benefits

Permits

Use of Data from External Animal Sample Collection

Use of Biological Samples from External Group
Departmental Approval/Additional Information

Declaration and Signature(s)

The blue hyperlinked questions provide quick access to the various questions on the form. The
qguestions shown in black cannot be accessed as they are not relevant to the particular submission
(for example, in the submission above, there are no supervising vets, therefore this question is not

required).

The panel on the left-hand side of each page provides the following functionality.

©

Previous

Takes one to the previous page of the form.

@

Next

Takes one to the next page of the form.

4

Navigate

Takes one to the page of the form on which all sections and questions of the form
are displayed. This enables one to move between pages of the form easily and

quickly.
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Takes one to the main screen which contains the tabs as well as the action buttons
to provide feedback and alert the administrator that the review has been
completed.

Timeline

Enables one to view/download the form as a PDF.

=

View as PDF
Displays all documentation uploaded as part of the form.
& Type Document Name File Name Version Date Version Size Download
Form Form Form.pdf -
Documents REC-A Study Permit Study Permit Study Permit.docx 21.8 KB

Shows any comments made on specific questions by the ethics administration team
2 during the initial check before the submission is assigned to the meeting for review.
Comments that you make will also increase this number.

Panel
Comments
Shows any changes made by the applicant in response to issues raised by ethics
2 administration team. This will be covered in more detail below.
Changes

Shows any comments made on the form as a whole by the ethics administration
O team during the initial check before the submission is assigned to the meeting for

review. Comments that you make will also increase this number.
Form
Comments

o+

New Comment

Action button to add new comments to a question on the form.

5.1. Reviewer Anonymity

The review comments that you make on the form for feedback and discussion at the REC-A
meeting are anonymous and independent.

e You cannot see other reviewer comments and they cannot see yours.
e The applicant cannot view any comments made online; they receive an Action Memo
containing the committee feedback after the meeting.

Your comments are visible to the ethics administration team and the REC-A Chair.
You are able to view comments that the ethics administration team have made during their initial

check of the submission. These comments go directly to the applicant, are visible to all and are not
review-related.
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5.2. Adding your Review Comments (Panel Comments)

To add a comment to a specific question, click on the New Comment action button in the left-hand
panel.

o

New Comment

The questions on that page will be highlighted and a [Select Me] will appear in the top-right hand
corner of the question block.

Select a question to comment on

4.7 State the parameters to be measured and the statistical method to be used for the analysis of results.

Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Maecenas porttitor congue massa. Fusce posuere, magna sed pulvinar ultricies, purus
lectus malesuada libero, sit amet commodo magna eros quis urna. Nunc viverra imperdiet enim. Fusce est.

4.8 State the methodology to be used for the acquisition and evaluation of the measured parameters. References should be indRded if the
methodology has been reported in published scientific literature. If the methodology has been developed during earlier experiments it
should be briefly described.

Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Maecenas porttitor congue massa. Fusce posuere, magna sed pulvinar ultricies, purus
lectus malesuada libero, sit amet commodo magna eros quis urna. Nunc viverra imperdiet enim. Fusce est.

Click on the [Select Me] of the question that you wish to comment on. Add your comment and
[Save].

Add Comment

Question Title ~ 4-8 Methodology

Comment 14 is not clearly what methodology you are proposing. Please rephrase.

oo (D




5.3. Reviewing and Editing your Review Comments

The [Panel Comments] button will increase with each comment made.

0

Panel
Comments

— 7

Panel
Comments

13

Click on the [Panel Comments] button to open all comments made. Any comments made by the
ethics administration team during the initial check will appear under the Previous tab.

Title

4.2 Details of
Animals

4.4 Holding
Density

4.7 Parameters
and Analysis

4.8 Methodology

4.11 Euthanasia

Current Previous

Panel Comments

History

Comment

Modus persequeris intellegebat mea ei, dolore labore est eu. Mel idque quaestio eu. In
tota oportere persecuti quo. Vix vocibus recteque pericula at, nam quem aeterno
voluptatum ne. Eu duo reque quando libris. Mel no etiam semper interesset.

Modus persequeris intellegebat mea ei, dolore labore est eu. Mel idque quaestio eu. In
tota oportere persecuti quo. Vix vocibus recteque pericula at, nam quem aeterno
voluptatum ne. Eu duo reque quando libris. Mel no etiam semper interesset.

Modus persequeris intellegebat mea ei, dolore labore est eu. Mel idque quaestio eu. In
tota oportere persecuti quo. Vix vocibus recteque pericula at, nam quem aeterno

voluptatum ne. Eu duo reque quando libris. Mel no etiam semper interesset.

It is not clearly what methodology you are proposing. Please rephrase.

Modus persequeris intellegebat mea ei, dolore labore est eu. Mel idque quaestio eu. In
tota onortere nersecuti auo. Vix vocibus recteaue nericula at. nam auem aeterno

Added

01/11/2022 17:13

01/11/2022 17:13

01/11/2022 17:12

01/11/2022 17:10

01/11/2022 17:12

Modified

You

You

You

You

You

Close

Click on [Edit] to open the comment that you wish to amend.

Comment

Update Comment

Question Title ~ 4-8 Methodology

It is not clearly what methodology you are proposing. Please rephrase.

Cancel

Update the Comment and [Save], or [Delete] the comment if required.

Please note: Edited/deleted panel comments remain as part of the history of the Project and can be
accessed by all under the History Tab under the Project ID link.
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5.4. Adding your General Comments (Form Comments)

General comments are any comments about the application that do not pertain to a specific form
question. A form comment should also include your recommendation on approval. Forms
comments are independent. Other reviewers cannot view your comments and you cannot view

theirs.

Clicking on the [Form Comments] action button opens the Form Comments pop-up.

Form Comments

O Current Previous History

Form
Comments
Close

Click on + Add Comment. Add your general comment and [Save].

Form Comments

Current Previous History

Date Added

Now You

Comment

Recommend approval with minor modifications.

£ o

Close

To edit a form comment, click on the [Form Comments] action button to bring up a list of the forms
comments that you have made. Click on the required comment.

Form Comments

Current Previous History

Comment / Date Added

Application should be considered as medium risk. 02/11/2022 10:43 AM
02/11/2022 10:36 AM

Recommend approval with minor modifications.

Close
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Edit and [Save] or [Delete].

Form Comments

Current Previous History

Date Added

02/11/2022 10:43 AM

Comment

P\pphcation should be considered as medium risk.

E3 o

Recommend approval with minor modifications. 02/11/2022 10:36 AM

Please note: Edited/deleted form comments remain as part of the history of the Project and can be
accessed by all under the History Tab under the Project ID link.

5.5. Submitting your Review

After completing your review, navigate to the main application screen by using the [Timeline] action
button.

Actions
roje tle: RECA TEST APPLICATION
Form Reference | licatior
Submissions  Subm omm Referen 10
) . Form Review Feadback
Timeline omments  Appication  Changes Req'd

6 &

e No _Feedback

Char Resubm t ppl

Click on one of the Feedback action buttons.

o Feedback - Changes Req’d: indicates that the submission is approved

Actions
with modifications

[\ /: . . . . .
V e Feedback - No Changes: indicates that the submission is approved
Bl G e with NO modifications

Submissions  Submissions Comments

1 O\ ﬁ e Feedback - Resubmission: indicates that you suggest a resubmission
o Rediew bt for this submission that should serve at a meeting after revisions have
Comments Application  Changes Req'd been made
<
ﬁ ﬁ =
Feedback - No  Feedback - RECA_My
Changes Resubmission Comments

Add an optional comment to the Timeline Notes, click the green [Feedback] button and then [Yes].
This comment will be visible to all on the Timeline as outlined in the The Timeline Tab section above.
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Feedback - Changes Req'd

Action Date:

Timeline Notes:  pginor changes

Timeline notes are not shared with Researchers

Are you sure you wish to perform this action?

5.6. Amending a Review after Submitting Feedback

Reviews can be amended after the [RECA_Review Feedback] button has been actioned. The
submission will remain under the Meeting Reviews tile in your Work Area until the RECA Meeting.

To amend your review, open the required form and click on [Review Application]. Click on the first
hyperlinked question to access the questions and navigate through the form using the [Previous]
and [Next] buttons.

A number will appear in the speech bubble next to any questions that have been commented on.
Please note that the number indicates the comments made by ALL committee members who have
already reviewed the submission. You will, however, only be able to view your comments.

Animal Types ) C)

4.1 To which category of animals do the animals to be used in this study belong (select all that apply)?

Domestic animals

Farm or agricultural animals
Feral animals

Laboratory animals

Higher invertebrates

Lower invertebrates (including insects)
Marine animals or aquaculture
Non-human primates

Wildlife animals

Zoo Animals

Other

R O

300

00

O00A0O0

Click on the speech bubble to open up the comment for editing or deletion.

Comments
Current Previous History
Title Comment Added Modified
4.2 Details of Modus persequeris intellegebat mea ei, dolore labore est eu. Mel idque quaestio eu. In 01/11/2022 17:13 You m
Animals tota oportere persecuti quo. Vix vocibus recteque pericula at, nam quem aeterno
voluptatum ne. Eu duo reque quando libris. Mel no etiam semper interesset.




17

Alternatively, Click on the [New Comment] action button in the left-hand button to add further
comments as outlined in the Adding your Review Comments (Panel Comments) section.

Panels comments and Form comments can also be directly accessed by using the relevant buttons
in the left-hand panel.

6 0 P

Panel Changes Form
Comments Comments

6. Attending to Revisions as the RECA Liaison

6.1. How will | know if | am the RECA Liaison on a Submission?

An email as shown below will be sent to you if you have been assigned as the RECA Liaison on a
submission that requires revision by the applicant, either for approval or for resubmission to a
subsequent RECA committee meeting.

Dear

You have been assigned to the following submission, either as the REC-A liaison or in a referral capacity (at
the request of the REC-A Liaison/Chair, etc.).

2022-REC-A-0104-184 : RECA RESEARCH Epsilon TEST

This submission can be accessed as follows:

e REC-A Liaison: Log on to MEOS (meos-review.mandela.ac.za) and access it via the Work Area tile
called [Changes to review].

e REC-A Referreal: Log on to MEOS (meos-review.mandela.ac.za) and access it via the Work Area tile
called [Referrals].

You will also be sent a copy of the Action Memo that the applicant receives.

Project ID: 0104

Title: RECA RESEARCH Epsilon TEST
Degree: Masters

Risk Level of Study:  Medium

PRP: Mrs Michelle Barnett

PI: Mr Thomas Smith

Submission Type: REC-A: Initial Application (Research)
Meeting Date: 25 November 2022

REC-A Representative: Ms MEOS Testl
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Title Comment

4.1 Animal Type(s) Are you sure that this the correct category?

4.4 Holding Density The holding density should be recalculated. It is not correct.
4.4 Holding Density Modus persequeris intellegebat mea ei, dolore labore est eu.

Mel idque quaestio eu. In tota oportere persecuti quo. Vix
vocibus recteque pericula at, nam quem aeterno voluptatum
ne. Eu duo reque quando libris. Mel no etiam semper
interesset.

4.7 Parameters and Analysis Modus persequeris intellegebat mea ei, dolore labore est eu.
Mel idque quaestio eu. In tota oportere persecuti quo. Vix
vocibus recteque pericula at, nam quem aeterno voluptatum
ne. Eu duo reque quando libris. Mel no etiam semper
interesset.

4.8 Methodology Modus persequeris intellegebat mea ei, dolore labore est eu.
Mel idque quaestio eu. In tota oportere persecuti quo. Vix
vocibus recteque pericula at, nam quem aeterno voluptatum
ne. Eu duo reque quando libris. Mel no etiam semper
interesset.

4.11 Euthanasia Modus persequeris intellegebat mea ei, dolore labore est eu.
Mel idque quaestio eu. In tota oportere persecuti quo. Vix

6.2. How will | know if an Applicant has made Revisions on a Submission?

You will receive an email indicating that the applicant has submitted the revisions for your review.

MEOS: Revised submission for review

donotreply@infonetica.net ©
To: MEOS Test1 Sat 11/12/2022 3:19 AM

The following revised application/report has been submitted on MEOS for your review. Please login and
review the changes.

Project Title: RECA RESEARCH Epsilon TEST
Submission Type: REC-A: Initial Application (Research)

The submission can be accessed by logging into MEOS via [meos-review.mandela.ac.za]meos-
review.mandela.ac.za or using the direct link: https://meos-review.mandela.ac.za/Timeline/Index/185

6.3. How do | Access all Submissions on which | am RECA Liaison?

Log on to your MEOQS review work area (meos-review.mandela.ac.za). The number on the [Liaison
Reviews] tile indicates the number of submissions that you are assigned to as liaison.

My Reviews (RECA) -

Meeting Reviews Liaison Reviews Referrals

| 2
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Clicking on the tile displays the list of submissions.

Assigned
Review Project Application Project Applicant Applicant Applicant Review Reviewer
Reference Id Type Title Title First Name Last Name Status Full Name
S RECA Changes
- é?ii'?:;’ g 104 g"e"s"ei::'a)" RESEARCH Mrs Michelle Barnett Submitted Ms MEOS Test1
Epsilon TEST (RECA)
RECA Changes
~ §?§§»T7E§A‘ 102 :;T:c;s::l)e nt PRACTICAL Mrs Michelle Barnett Required Ms MEOS Test1
Gamma TEST (RECA)

The Review Status indicates if the applicant needs to make revisions and submit to you for approval,
or if the revisions have been made and you need to review the changes. There are 4 possible review
statuses.

° Changes Required (RECA) — no action is required by you as the liaison. The applicant
needs to make revisions based on the Action Memo emailed. The Action Memo will also
be copied to you.

° Changes Submitted (RECA) — ACTION is required by you. The applicant has made
revisions; the form has been re-signed and submitted. You need to review the revisions
and either request further revision or approve the revisions.

° Resubmission Required (RECA) — no action is required by you as the liaison. The applicant
needs to make revisions based on the Action Memo emailed. The Action Memo will also
be copied to you.

° Resubmission by Applicant (RECA) — ACTION is required by you. The applicant has made
revisions; the form has been re-signed and submitted. You need to review the revisions
and either request further revision or approve the revisions.

Click on an application which has been revised and then [Review Application] to open the form and
review the changes made.

Project Title: RECA RESEARCH Epsilon TEST

CArmm Dafaranc~a* DY ~nlica ~n (Roacaarch)
Form Reference: REC-A: Initial Application (Research)
Review Reference: 2022-REC-A-0104-185
Delete submission
RECA_Request
More Changes
Project Id Applicant Name Mrs Michelle Barnett

Current Committee Research Ethics Committee (Animal Current Status:

Application Type: Application (Research) Meeting

Conflicted Users: None Centre: Mandela
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After opening the form, the number of changes made by the applicant is indicated on the [Changes]
tile. (Please note: The Panel Comments and Form Comments buttons will only show your review
comments made during the initial review of the form for the RECA committee meeting).

Actions

8 s 7
Timeline View as PDF Documents

Project Id 104

4 1

Panel Form
Comments Comments

Section

Section 1: Type of Research Study

Section 2: Investigator Information

Review Reference: 2022-REC-A-0104-185

Version

REC-A: Initial Application (Research)

Questions

Research Study Type / Recommended Reading

PRP/PI Details | Co-workers | Supervising Veteriry

Clicking on [Changes] opens up a list of all questions that have been changed by the applicant.

Changes

4.1 Animal Type(s)

4.4 Holding Density

4.7 Parameters and Analysis
4.8 Methodology

4.11 Euthanasia

5.3 Benefits of the Study
PRP Declaration/Signature

Click on a hyperlink. This takes you directly to the question with a [View Changes] button.

Note: The applicant has changed an answer within this panel since the last submission.

Parameters and Analysis

The parameters to be measured are: Blah de blah de blah.

4.7 State the parameters to be measured and the statistical method to be used for the analysis of results.

Click on [View Changes] to view the changes made. Deletions are indicated in red. Additions are
indicated in green. The [View Changes] button will change to a [View Latest] button.
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N

Note: The applicant has changed an answer within this panel since the last submission. | View Latest

Parameters and Analysis (Submitted on 01/11/2022)

4.7 State the parameters to be measured and the statistical method to be used for the analysis of results.

teremThe ipstmparameters deterto sitbe amet;measured eenseetetuerare: adipiseingBlah efitde blah de blah. Maeeenasperttitercongue

Clicking on the [View Latest] button shows the revised version only.

Note: The applicant has changed an answer within this panel since the last submission. Ve ELIES

Parameters and Analysis

4.7 State the parameters to be measured and the statistical method to be used for the analysis of results.

The parameters to be measured are: Blah de blah de blah.

6.5. How do | Request Further Changes to a Form?

If you are not satisfied with the revisions made, add a comment to the relevant question(s) using
the process outlined in the Adding your Review Comments (Panel Comments) section above.

When all comments have been added, click on the [Timeline] action button.

Actions
Previous Next Navigate
B & ¢
Timeline lew as PDF Documents

Click on the [RECA_Request More Changes] button.

Actions
2 0 6
Form Project Panel

Submissions  Submissions Comments

1 Qo

Form Review RECA_Liaison
Application Approve

Add Notes

RECA_Request
More Changes




22

An Action Memo will be generated for the applicant. The comments that you have made on the
latest submission will be pulled into the Action Memo. They can be edited to ensure that they are
clear for the applicant.

Please ignore the banner in yellow. This is a standard banner. Your comments will not be visible to
the applicant on the form, and you are unable to mark them as visible. Your comments will be sent
on the Action Memo as below.

Edit the Action Memo using the editing tool in the centre of the screen.

Add a mandatory timeline note, for example: Changes to Q4 required.

When you are satisfied with the Action Memo, click the green [RECA-Request More Changes] button
and then [Yes].

RECA_Request More Changes

Action Date: Now y

Timeline Notes:” Changes to Q4 required

B I 1 | | (inherited font) ¥  (inherited size) v A v A v += | Format v X, X

FURTHER REVISIONS REQUIRED TO ETHICS SUBMISSION

Project ID: 0104

Title: RECA RESEARCH Epsilon TEST
Submission Type: REC-A: Initial Application (Research)
REC-A Representative: Ms MEOS Test1

The revisions to the above mentioned submission have been reviewed.
Further revisions are required as per the comments below.

Please log onto MEOS (https://meos-apply.mandela.ac.za/Project/Index/189) and address these comments. Thereafter, the form must be electronically signed by all
parties and submitted on MEOS. This will alert the REC-A representative that there are additional revisions to review.

Reviewer Title Comment
4.7 Parameters and Analysis I am not happy with this revised answer.
Perhaps you should consider...........
4.11 Euthanasia You need to elaborate on the word source.

Where exactly are they to be returned?

After sending the Action Memo, the status of the form will be updated from Changes Submitted
(RECA) to Changes Required (RECA).
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Project Title: RECA RESEARCH Epsilon TEST
Form Reference: REC-A: Initial Application (Research)
Review Reference: 2022-REC-A-0104-185

Project Id 0104 Applicant Name! Mrs Michelle Barnett
Current Committee Research Ethics Committee (Animal) Current Status Changes Required (RECA) _
Application Type Application (Research) Meeting: Unassigned

By sending the Action Memo, all signatures are invalidated, and the form is opened for the applicant
to make further revisions and resubmit for your approval.

IMPORTANT:

It is not mandatory to make comments on the form to request further changes. You may prefer
to have a meeting or a telephone discussion with the applicant. You may have used email to
convey the further changes required. However, you MUST re-open the form for the applicant
using the [RECA_Request More Changes] action button, even if there are no comments on the
Action Memo. If this is not done, the applicant is unable to make the revisions for your approval.

7. Approving Revisions

When you are satisfied with the changes, navigate to the main screen of the form by clicking on the
submission under the [Liaison Reviews] tile or navigating to it from the form itself using the
[Timeline] action. Click on the [RECA_Liaison Approve] action.

S U © Project Title: RECA RESEARCH Epsilon TEST

Form Project Panel
IS

Submissions = Submissions Coj
RECA _Liaison

Form Review
Comments Application Approve

Form Reference: REC-A: Initial Application (Research)
Review Reference: 2022-REC-A-0104-186

\J

/

RECA_Request
More Changes

Add a comment to the mandatory timeline notes box and click [RECA_Liaison Approve] and [Yes].

RECA_Liaison Approve

Action Date: Now

— Timeline Notes:* | pe\icions approved
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This action sends an email to the ethics administration team informing them that you have approved
the submission and the approval letter can be issued.

After you have approved the submission, it will no longer be found in your Work Area.
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